Office 2000 SP2
We examine the issues
surrounding the latest set
of bug fixes for Microsoft
Office 2000.
By PCSA Staff

I

n December last year, Microsoft issued Service Pack 2 for Office 2000. Unlike
Windows OS service packs, those for applications are rarely cumulative and
this one is no exception. So before you upgrade a user’s Office 2k installation
to SP2, you’ll need to ensure that SP1 or SP1a is already installed. You will find a
full list of all the bugs fixed in SP2 on the Web at support.microsoft.com/support/kb/articles/Q276/2/57.asp. If you have access to the Knowledge Base, the
list is in article Q276257. The list is also documented in an Excel worksheet called
SP2Changes.XLS, which is part of the SP2 set of files. This article explains some
of the fixes, but the aforementioned list contains the full complement of fixes plus
links to more detailed explanations of each.
Two separate versions of the SP2 update are available - one for upgrading
administrative installation points and the other for upgrading standalone computers. SP2ADMIN.EXE is the version for administrative installation points. This
self-extracting executable contains four Windows Installer patches (MSP files)
that need to be applied separately to the administrative share. SP2UPD.EXE is the
version for standalone computers. This version includes an integrated Setup
program that enables you to easily update computers not associated with an
administrative installation point. Both files are on your PCSA CD-ROM in the
resource files area, and are 30 MB and 9 MB in size respectively.
For most organisations, Microsoft says that the best way to deploy SP2 is to create
an updated image of the product on an administrative installation point. Local
users can then connect to this share and update the version of Office installed on
their computers. If you are staging your upgrades over a period of time, you may
need to maintain two administrative installation points during the process. The
original share serves as a source for clients who have not yet upgraded. Until they
upgrade, clients may need access to the original share for install-on-demand,
automatic feature repair, and other services. The updated share serves as the
installation point for SP2. If you need to create administrative installation points
in multiple locations, you can copy the folder hierarchy and files from one
administrative installation point to additional servers.
Included in the SP2 release are various security-related and other important fixes
that have been released individually since SR1 was made available. If you have
already installed one or more of these, SR2 will handle this situation and will still
install correctly. Among the post-SR1 fixes incorporated into SP2 are the email
security update for Outlook, the proofing tools hyphenation fix for Word, the mail
command security update for Word, the HTML data fix, the Register.ID fix for
Excel, the HTML script vulnerability for Excel and PowerPoint, and the Word
mailmerge fix. Some of these are described in more detail below.

Mac Users
If you use Outlook for Macintosh on a Microsoft Exchange Server and install
Office 2000 SP2 you will experience a problem that affects the Outlook for
Macintosh Inbox Assistant rules. After running Outlook 2000 SP2 for Windows
on an Exchange Server mailbox, the Inbox Assistant rules cannot be retrieved.
The Exchange Server mailbox for Outlook automatically upgrades the rules from
the Inbox Assistant format, used by Outlook for Macintosh, to the Rules Wizard
format used by Outlook SP2 for Windows. The rules will continue to function as
Rules Wizard rules, but you will no longer be able to add, remove or change rules
from Outlook for Macintosh.
To be able to add or change rules after installing Office 2000 SP2 for Windows,
you must delete the upgraded rules from the Outlook 2000 SP2 Rules Wizard and
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then recreate your Inbox Assistant rules from Outlook for Macintosh. To delete
rules from the Outlook 2000 SP2 Rules Wizard, click Rules Wizard on the Tools
menu. Write down the current rules, so that you can refer to them when recreating
the Inbox Assistant rules. Select the rules you want to delete, and then click Delete.
Click OK to close the Rules Wizard. To recreate your Inbox Assistant rules from
Outlook for Macintosh, click Inbox Assistant on the Tools menu. Click the Add
Rule button, then recreate the rules. Click OK to close the Inbox Assistant.
Office binder crashes when closing print preview.
Rendering of dashed lines in
embedded chart or graph is inconsistent.
Justify command does not insert
spaces between text from each
cell.
Error message: “ORA-00923:From keyword not found where
expected”.
Labels on XY scatter graphs disappear in print preview.
Graph font changes from sans
serif to serif.
On Error Resume next takes
longer to run than in Excel 97.
Linked charts lose custom colours when you update source
data.
Format Painter causes Excel to
stop responding if Date Watch
add-in is enabled.
Access Violation error running
VBA code with UserForm, SaveCopyAs and Save functions.
Cell formulas change when you
copy a worksheet with an embedded chart.
Memory leak when Excel calculates user-defined functions.
Excel 95 auto_xxxx defined
name values change when imported into Excel 97 or 2000.
Server application cannot be
found when you open embedded Excel object.
Japanese Excel crashes when
you type two-digit number and
character.
No error message returned to
VBA on failed save.
“Do you want to save the
changes you made to { ?” in
French Excel 2000.
PivotTable of OLAP data does
not display data correctly in
Japanese Excel.
Spelling checker does not offer
suggestions for some misspelled words that Word 2000
checker does.

Figure 1 - Excel problems
fixed in Office 2000 SP2.
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Outlook Security Patch
Although most Windows and Office service releases are must-have patches that
can be installed on all users’ machines without a second thought, this one is
different. The security update for Outlook included in Office 2000 SP2 radically
changes the way that Outlook works, in order to help prevent the spread of macro
viruses such as Melissa and the Love Bug virus. It works by adding three new
levels of security. Email attachment security prevents users from accessing several file types when received as attachments. Affected file types include executables, batch files, and other file types that contain executable code often used
by virus writers.
Object Model Guard prompts users with a dialog box when an external program
attempts to access their Outlook address book or send email on their behalf, which
is how viruses such as ILOVEYOU spread. Finally, the default security settings
for Outlook have been changed, and increase the default Internet security zone
setting within Outlook from “Internet” to “restricted sites.” In addition, active
scripting within restricted sites is disabled by default.
Once you install the SP2 update, Outlook users will not be able to access attachments with file types that could run executable code or change settings on a
computer. These file types are known as Level 1 security files and are those with
extensions of .EXE, .COM, .BAS, .VBS, .JS, .ISN, .LNK and .PIF. Links to Web sites,
ie, URLs, are also included. If a user receives a message that contains an attachment that cannot be accessed, the inbox will display the paperclip in the attachment column to let the user know that the message has an attachment. When the
message is opened, the attachment will not be available.
On the File menu, the Save Attachments command and the View Attachments
command on the shortcut menu will not be available for the message. In the case
of a message with multiple attachments, any of the unsafe attachments will not
be accessible but other attachments will be retained. If a user receives a message
containing a Level 2 file as an attachment, he or she will be warned that the file
must be saved to disk before it can be opened. It can’t be executed directly from
within Outlook. The list of Level 2 files is definable by users and system administrators - by default the list is empty.

Sending Attachments
When you attach a file to email, the update checks the file type when you send
the message. If the file type is on the list of restricted files, you will be warned that
other Outlook users may not be able to open the attachment. If you click Yes, the
message is sent with the attachment. If other users have the update installed, the
attachment will be inaccessible. If you click No, the message will be returned to
you for editing, which will involve removal of the attachment.

Mail Ban
Another aspect of the Outlook security patch, as mentioned above, is that programs are prevented from sending mail without your permission. Programs
cannot automatically access the Outlook address book or contacts list, or send
messages on a user’s behalf. In either case, Outlook will prompt the user, ensuring
that Outlook can’t be used to distribute mass email without the user’s permission.

Defaults
Default security zone settings are set to Restricted Sites (rather than Internet) by
default, and active scripting within restricted sites is disabled by default when
the patch is installed. The Restricted Sites security zone disables most automatic
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scripting and prevents ActiveX controls from opening without the user’s permission. These security features help protect users from many viruses that are spread
by means of scripting.

Further Details
DocProperty field truncated after 127 characters.
Date/time form fields not converted correctly from Word 97.
Caps Lock key stops responding with French keyboard
driver installed.
“Run-time error 4605: this command is not available” when
you use PageSetup property.
Table with header rows appears
damaged in multicolumn document.
Incorrect bookmark names for
form fields in vertical table cells.
Word document in frame in Internet Explorer freezes after editing.
File size increases when Word
document is embedded as ActiveX document.
Leading zeros are ignored in
number form field format.
Outlook stops responding
when you use Word as your
email editor.
Word stops responding when
communicating with OLE1
OCX through DDE to VBA
form.
Invalid Page Fault when you try
to print from Photo Editor.
Day name is incorrect in document after you save it as Word
6.0/95 or HTML.
Inline graphic images are lost
when you save document as
HTML.
Access Violation when you use
CommandBarButtonEvents
click event handler.
Font size changes when you
open RTF file from earlier Word
versions.
Templates do not appear in new
dialog box.
Invalid Page Fault when you
split cells with “merge cells before split” turned off.
Word stops responding when
you open or edit a document
that contains a list.

Figure 2 - Word 2000
problems fixed by SP2.
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For more information about the Outlook security update, check out Microsoft
Knowledge Base article Q262634 which covers known issues. You should also
read article Q263297, for information on customising the update.

Bugs Fixed
The remainder of this article looks at some of the bugs and problems with Office
2000 that are fixed by SP2. However, before installing SP2 in order to correct any
bug, you must carefully consider the consequences of permanently depriving
users of the facility to send or receive executable attachments with Outlook.

Word 2000 Proofing Tools Hyphenation
When working on long documents in Microsoft Word 2000, the hyphenation
feature of the proofing tools for some European languages may stop functioning,
or may function only sporadically. The Word 2000 Proofing Tools Hyphenation
Update, included in SP2, corrects the hyphenation feature so that it works
properly with long documents.

Mail Command Security
The Word 2000 SR1 Mail Command Security Update eliminates a security vulnerability that could allow a malicious hacker to send a virus through email by
using the Word 2000 EmailSend command in VBA. Once this update, which is
included in Office 2000 SP2, is installed, Outlook will prompt the user if the
EmailSend command in the Word 2000 Object Model attempts to send email. This
update does not affect email sent manually from within Word, but only messages
sent by VBA programs.

HTML Data And Register.ID
The HTML Data update fixes a problem that could allow an HTML file to shut
down Word, Excel or PowerPoint and possibly run malicious code. The update
is included in Office 2000 SP2. The REGISTER.ID update is a fix for Excel. It
eliminates a loophole that could allow the worksheet tools to do malicious acts,
such as deleting and overwriting files without the user’s input or verification. The
update disables the REGISTER.ID function.

HTML Script Fix
The SP2 release also includes the HTML Script fix for Excel and PowerPoint. The
patch closes a security hole in the Excel and PowerPoint object models that could
expose them to unsafe scripts when a user views a Web page or HTML email
message. Once the patch is installed, Excel 2000 or PowerPoint 2000 can only be
scripted if the “Initialize and script ActiveX controls marked unsafe” option in
Internet Explorer is set to “Enable”.

Outlook Collaboration Data Objects
Another fix which was released previously but which is now also included in SP2
is the above-mentioned patch for Outlook. It helps provide a higher level of
security against macro viruses, and others that spread via email. CDO is a
technology designed to simplify the creation of applications with messaging
functionality, or to add messaging functionality to existing applications. For
example, CDO and Active Server Pages provide script support to create, send and
receive email on a Web site.

Word 2000 Mail Merge
The Word 2000 Mail Merge Security Update, again included in Office 2000 SP2,
protects users from a bug in the mail merge function in Word with Access
databases as a data source. Because the mail merge function in Word can allow
an Access database to run macro code automatically - with no macro protection
warnings turned on - hackers could entice your users to open a specially constructed mail merge Word document (from an email attachment or a link on a
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Changing the default language setting does not appear to work.
Linked pictures lost when unpacking presentation.
Unable to save presentation after a second user opens same presentation.
Cannot ungroup inserted Amigo 2000 charts.
Error message closing PowerPoint presentation from public folder.
Error message: the Web page you requested is not available offline.
Pasted slide does not apply formatting from notes master.
Promote/Demote don’t work correctly after pasting bulleted list text box
from slide master.
Screen saver is reset to none after you run a .PPS file or use /s switch.
Programs can be run while you view a Web page or HTML message.
PowerPoint quits unexpectedly or stops responding when you run slide
show.
Table borders are dropped
when you open document
saved as .RTF.
Vertical changed-line bars are
printed incorrectly after you revise a table.
Word crashes after automatically correcting text.
Word 95 document is changed
to “Word Document” when
opened in Word 2000.
Hyphenation stops working in
Word 2000 for some European
languages.
Footnote 1 opens when you
double-click any footnote in an
RTF document.
Width of table cells changes
when you open Word 95, word
97, or RTF document.
Localized field format switches
in Word 95 documents are incorrect in Word 2000.
Syntax error when you update
sum fields in Word 97 document.
Documents
deleted
when
opened read-only in ODMA
program.
Negative number on macro button is not aligned at decimal tab.
Macros enabled when you use
access database file in Word.
Macros enabled when Word
automatically opens ASD files.

Figure 3 - PowerPoint fixes.
hostile Web site) that might cause arbitrary code to run. The update increases the
security in the connection between Word mail merge documents and Access
databases. If the Access database is located on the Internet or in a Restricted sites
zone, then the mail merge document will prompt for a new data source before
executing the macro.

Access Problems Fixed
When automating Access 2000 and issuing the Quit method, Access does not shut
down. You do not receive any error messages but Access remains in the task list.
This is a bug in Access 2000 and is fixed in SP2. It happens because Access 2000
is configured to run under the context of a user that is different from the currently
logged-in user. The Quit method for Access 2000 only shuts down Access when
it is running under the context of the same user that is currently logged into the
system (the Interactive User).
Another Access 2000 bug occurs when a user is opening a simple unbound form
in Design view across a wide area network. This takes much longer than opening
the same type of form and data source in Access 97. The problem is fixed by SP2.
Also, when a user opens an Access database, VBA projects may not be loaded.
This happens because, during the load process, VBA reads the “Project” stream
to determine which modules are available. VBA reads the complete stream into
memory in one operation. If the “Project” stream exceeds a particular size, the
load process stops and an error occurs. SP2 fixes this.

Rendering Of Dashed Lines
In any Microsoft Office 2000 product, when you click Object on the Insert menu
to embed a Graph 2000 object or an Excel Chart object, the rendering of dashed
lines on the screen and in print is not consistent with the way that the object is
rendered while it is being edited. In normal view, some of the dashes in the lines
appear to be heavier weight and look different than when the object is active for
editing. SP2 fixes this problem.

Word crashes when you use
Polish proofing tools.
Grammar checker suggests incorrect capitalization of “Mainland” or “Republic”.

PCSA
Figure 2 - Word 2000
problems fixed by SP2
(continued).
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New Reviews from Tech Support Alert
Anti-Trojan Software Reviews
A detailed review of six of the best anti trojan software programs. Two products
were impressive with a clear gap between these and other contenders in their
ability to detect and remove dangerous modern trojans.
Inkjet Printer Cartridge Suppliers
Everyone gets inundated by hundreds of ads for inkjet printer cartridges, all
claiming to be the cheapest or best. But which vendor do you believe? Our
editors decided to put them to the test by anonymously buying printer cartridges
and testing them in our office inkjet printers. Many suppliers disappointed but we
came up with several web sites that offer good quality cheap inkjet cartridges
with impressive customer service.
Windows Backup Software
In this review we looked at 18 different backup software products for home or
SOHO use. In the end we could only recommend six though only two were good
enough to get our “Editor’s Choice” award
The 46 Best Freeware Programs
There are many free utilities that perform as well or better than expensive
commercial products. Our Editor Ian Richards picks out his selection of the very
best freeware programs and he comes up with some real gems.
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